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You may not reproduce, transmit, transcribe, store in a retrieval system or translate 
into any human or computer language this manual and software. These actions, in 
any form or by any means, are illegal without the express written permission of Pu-
r itas Spr ings Software. 
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During the period of time before a major upgrade, if the disks that make up the then-
current version of this software are defective, then return the software to Pur itas 
Spr ings Software, 645 McKee Trail, Hinckley, Ohio 44233-9209 and replacement 
disks will be mailed to you. Pur itas Spr ings Software reserves the right to define 
and decide what constitutes a major upgrade. 
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Pur itas Spr ings Software provides Ohio Business Forms for Windows, consisting 
of both the software and this manual, "AS IS." The software and manual carry no 
warranty as to performance, merchantability or fitness for any particular use. Pur i-
tas Spr ings Software specifically disclaims all warranties, express or implied, re-
garding the software or our services, and Pur itas Spr ings Software does not war-
rant that the software or services are free from defects, interruption, errors or other 
program limitations. For states containing limitations on implied warranties, any 
such implied warranties are limited to 60 days from the date of purchase. You as-
sume all liability and responsibility for the accuracy of any form produced by this 
software. Recognizing this, Pur itas Spr ings Software has exercised due care in the 
preparation of the software and manual. In no event, however, shall the authors or 
publisher be liable for direct, incidental or consequential damages, or damages of 
any type, arising from the use of Ohio Business Forms for Windows. 
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Ohio Business Forms (OBF) is a 32-bit Win-
dows application that was designed in Windows 
XP, although it runs in any 32-bit Windows envi-
ronment including Windows 2000, Windows ME, 
Windows 98 and Windows 95 operating systems. 
Because OBF is a true 32-bit application it does 
not run in older operating systems such as Win-
dows 3.1, Windows 3.11 or Windows for Work-
groups. 
 
System Requirements. OBF requires a Pentium or equivalent processor with at 
least 32 MB of RAM. OBF comes on one CD and requires approximately 8 mega-
bytes of hard disk space. OBF also requires that the Borland Database Engine - 32 
bit version (BDE32) be installed on your computer. The BDE32 is included on the 
OBF CD. 
 
OBF requires a SVGA video card capable of 800 x 600 resolution with a minimum 
of 256 colors and a Windows-compatible printer. 
 
WARNING: United States Copyright laws protect OBF as the property of Pur itas 
Spr ings Software. Your OBF distribution disk contains a registered serial number 
that is located in various places within the software. Possessors of unauthorized cop-
ies violate Federal law. 

 
Note that the files on the Puritas Springs disks are compressed. You cannot copy 
them to your hard drive manually. You must "install" them using the SETUP appli-
cation. 

$���
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Overview 
 

You install Ohio Business Forms (OBF) to your 
computer by simply inserting the distribution CD. 
The InstallShield installation process performs two 
operations—installing OBF and installing or updat-
ing the Borland Database Engine (BDE32). Al-
though the installation process is automatic, you can follow the steps below just to 
make sure that everything’s going properly. 
 
WARNING: Many of the installation problems we encounter in technical support are 
the result of the user running programs in the background during installation. When 
you install OBF, you should make sure there are no applications running. Therefore, 
there should be no application buttons on the task bar. If you’ re unsure how to check 
what’s running, we recommend rebooting your computer and doing the install right 
after you’ve rebooted and before you run any other application. Note that some appli-
cations execute automatically on startup, these too should be terminated before begin-
ning the install. You may want to ask someone to help on this very important step if 
you’ re unsure about how to check for running applications. 
 

Network Installations 
 

In the case of network installations, the types and implementations are diverse and we 
cannot give network-specific technical support although we answer questions about 
OBF to assist network administrators during installation and setup. We also have a 
Network Installation section at the end of this manual that contains much helpful in-
formation in this regard. Note that you must have a network license to be able to set 
OBF for use on a network. 
 

Installation Steps 
 

A.  Place the distribution CD in your drive. 
 
B.  On most systems, installation will begin automatically, however, if the installa-

tion wizard does not star t automatically, perform the following three steps: 
 

� � Press the Start button��
�
2. Click on the Run item; and 
 
3.   Type the command shown below. Note that if you’ re installing from a dif-

ferent drive, you must use the correct drive letter. 
 

D:SETUP.EXE 
 

%����##
���&' (%����##
���&' (%����##
���&' (%����##
���&' (����
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C.   The Preparing to Install screen will appear briefly as InstallShield sets itself up 
to begin the installation process. Typically, you’ ll see a progress meter until the 
Welcome dialog appears. Click the Next button to proceed with installation. 
Click Cancel if you want to abort installation. 

�
D.  The Pur itas Spr ings Software L icensing Agreement appears in the next dialog. 

Click on the I accept ... option to accept the terms and conditions of the license, 
and then click on the Next button to continue with the installation. If you do not 
agree to the terms of the Licensing Agreement, you will not be able to continue 
installing the program. 

 
E.  Verify your user identification information and click the Next button. Unless you 

have a compelling reason to do otherwise, leave the Anyone who uses this 
computer option selected. Note that this option may only appear on Windows 
2000 or Windows XP systems. 

 
F.  You will now see the Ready to Install dialog. Click the Install button to begin 

the actual installation process. As files are copied and installation tasks are com-
pleted by the InstallShield Wizard, a progress meter will keep you informed as the 
stages of installation are completed. 

 
G.   When installation is complete a Installation Wizard Completed dialog appears 

on the screen and you can click the Finish button. 
 

�Running The Program�
�
When installation is complete, a OBF icon is placed on your desktop. You can start 
the program by clicking on the icon. You can also run the program in the conven-
tional manner by clicking on the Start button in the lower, left corner of your screen, 
then click the Programs submenu, then the Pur itas Spr ings Software submenu, and 
finally click on the OBF item. 
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Updating and Reinstallation 
 

If you ever receive an updated OBF CD, or if you download an upgrade over the 
Internet, please read this section for additional useful information. In order to re-
install OBF it is usually necessary to uninstall or remove the existing version.  In 
this context, it is important to know that removing OBF using Windows’  Add/
Remove function will NOT delete or  harm your  client files. That being said, 
you should always back up the Files subfolder that is contained within the OBF 
program folder. It is there that your client files are stored. The steps for uninstal-
ling or removing OBF are: 
 
1. Click on the Start button. From the Start menu select Control Panel. Note 

that in earlier Windows versions, you may need to navigate to Control Panel 
in a different way (via the Settings item). However, once in Control Panel, 
double-click the Add/Remove Programs icon. 

 
2. Select OBF from the program list within the Install/Uninstall tab. Once the 

OBF item is highlighted, click the Remove button. Note that on earlier ver-
sions of Windows the removal process may involve slightly different steps. If 
you’ re not familiar with this process it is best to ask someone to help you. 

 
3.   As the uninstall process proceeds you will see a progress meter. When the 

process of completed, you are returned to the Add/Remove Programs applet 
and the OBF should be removed. 
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Ohio Business Forms (OBF) starts by 
displaying an empty desktop area. You 
can start working on different business 
forms by clicking on the Display 
menu. This tutorial will take you 
through the process of completing 
Form 532—Initial Articles of Incorpo-
ration. However, you can display and complete any form in any order by going to the 
Display menu. Completing a form is a simple four-step process as explained below. 
 
OBF can do much to help automate the process of completing the forms. When dupli-
cative entries are required, OBF will usually complete such entries automatically. 
Also, the Default.obf file can be opened and set up with information that doesn’ t 
change from one file to the next. For example, if you always prepare forms in the 
same county, you might open the Default.obf file and enter and save the county name 
wherever it appears. If you end up needing to change the county you can always do 
so, but for each new form you start, the county name will be there already. You can 
find the tutorial file on your hard drive as one of the installed client files named Sam-
ple.obf. 
 
When you start OBF, you get a complete set of blank forms (blank except for any de-
fault information that may be present in the Default.obf file). Go to the Display 
menu and click For Profit Corporation. From the submenu, select Form 532-Initial 
Articles of Incorporation, and then select Page 1. When the first page of Form 532 
appears, the focus is in the Yes  checkbox field in the top right corner of the form. 
The focus will move around on the form as you enter information. Use the <TAB> 
���� key to move from field to field. You can also point to different areas of the form 
with your mouse to jump to other areas of the form without needing to hit ����  repeat-
edly. 
 
Here are the recommended steps for completing Form 532 that will be the subject of 
the succeeding sections of this manual. 
 

Step 1. Select A Form From The Display Menu 
 
Step 2. Give The File A Name 
 
Step 3. Complete Any Additional Pages 
 
Step 4. Print The Form 

)����
���%����� ��
��)����
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Step 1. Select A Form From The Display Menu 
 
Following the reminder in the middle of the startup screen, go to the Display menu 
and select For Profit Corporation, then select Form 532-Initial Articles of Incor-
poration, then select Page 1. When the first page of Form 532 appears, the cursor 
is blinking in the Yes checkbox in the top right corner of the screen as shown in Fig-
ure 1 below. 

· We wanted to place a check in the Yes box. Do that by either pressing the space 
bar on your keyboard or clicking in the checkbox area highlighted in silver grey. 
When you are through, press the �  (Tab) key to move to the next field. 

 
· We will leave the No check box blank, so press the �  key twice to move to the 

move the focus to the Name of Corporation field. Notice that OBF already 
knew that you had selected For Profit Corporation from the menu, so it com-
pleted the Articles of Incorporation For Profit checkbox and skipped the other 
two inapplicable checkboxes. In the Name of Corporation field type: The Mi-
nas Tirith Corporation. Press the �  key. 

 
· Complete the remaining fields as shown below. Press �  after each entry to 

move to the next field. 
 

� �� � �� �� 	�� 
 �� �� 
 �� �� � �� �� 	�� 
 �� �� 
 �� �� � �� �� 	�� 
 �� �� 
 �� �� � �� �� 	�� 
 �� �� 
 � ������ ���� ��� ���� �� � �
 ���� � 
 �� 
 �� ��
 � ��� � � � �� 	�� � �� � � �� � ����� � � � � �� �
 � ��� ���� ��� �� � �� � 	�� ���� ��� ���� �� � �
 ���� � 
 �� 
 �� ��
 � ��� � � � �� 	�� � �� � � �� � ����� � � � � �� �
 � ��� ���� ��� �� � �� � 	�� ���� ��� ���� �� � �
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 � ��� � � � �� 	�� � �� � � �� � ����� � � � � �� �
 � ��� ���� ��� �� � �� � 	�� ���� ��� ���� �� � �
 ���� � 
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 � ��� � � � �� 	�� � �� � � �� � ����� � � � � �� �
 � ��� ���� ��� �� � �� � 	����
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            Field                                                       Answer  
              ------------------------------------------------------------------------------- 
              Location (City)                                      Cleveland 
              Location (County)                                 Cuyahoga 
              Effective Date                                       07/04/2005 
              Additional Provisions ...                       Leave unchecked 
              Purpose (line 1)                                    To design, build, market and sell custom-built oak 
                                                                              furniture, cabinetry and other fixtures 
              Purpose (line 2)                                    in addition to any other legal business pursuit 
                                                                              in the State of Ohio. 
              No of Shares                                         500 
              Type                                                       Common 
              Par Value                                               $1.00 
 
Now the middle part of your screen should look like the one shown in Figure 2 be-
low. Note that screen appearance depends on the size of you monitor and the display 
resolution of your graphics adapter. The picture below is from a 19”  monitor at 1280 
x 1024 pixels. 

� �� � �� �� 	�� 
 �� �� 
 �� �� � �� �� 	�� 
 �� �� 
 �� �� � �� �� 	�� 
 �� �� 
 �� �� � �� �� 	�� 
 �� �� 
 � ������ ���� ��� ���� �� � �
 ���� � 
 �� 
 �� ��
 � ��� � � � �� 	�� �� � �� �� 
 ���
 � �
 ���
 �� �� ��� ��� � �� �� � ��� 	�� ���� ��� ���� �� � �
 ���� � 
 �� 
 �� ��
 � ��� � � � �� 	�� �� � �� �� 
 ���
 � �
 ���
 �� �� ��� ��� � �� �� � ��� 	�� ���� ��� ���� �� � �
 ���� � 
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 �� ��
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 ���
 � �
 ���
 �� �� ��� ��� � �� �� � ��� 	�� ���� ��� ���� �� � �
 ���� � 
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 �� ��
 � ��� � � � �� 	�� �� � �� �� 
 ���
 � �
 ���
 �� �� ��� ��� � �� �� � ��� 	����
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Step 2. Save Your  File 
 
Now that you have worked for a few minutes, you will want to be sure to save your 
client file by giving it a meaningful name. Select Save As from the File menu. 
When prompted for a name, you can use any legal Windows name you choose. You 
might use the client©s name, i.e., The Minas Tirith Corporation.  Always use the .
OBF extension; better yet, leave it off completely and OBF will put it on for you,    
i.e., The Minas Tirith Corporation.OBF. 
 
When you save a file you are saving the entire set of documents contained in OBF. 
This is true even if you are using only one document! You might think this wastes 
space, but OBF files are actually quite small by today’s standards. Saving files this 
way allows OBF to copy data from one form to another automatically, so if you do 
the Initial Articles of Incorporation and later do a Dissolution, much of the informa-
tion from the Articles will flow automatically to the Dissolution. In the context of 
naming files, therefore, it may be better to name your files after the client (i.e., ABC 
Company, Inc.OBF) rather than the document (i.e., Acme Corporation Articles 
of Incorporation). 
 
Not only can you give a file any name you want, but you can also save the file wher-
ever you want. By default, the Save As dialog will open to the directory that is set 
using the Option menu’s Set Default OBF Directory command. The general rule 
about saving is: If you haven©t named your file, use the Save As command to give it 
a name. If you already named the file (you will see the name on the title bar at the 
top of the screen—see Figure 2 on the preceding page), use the Save command or 
the Save button. 
 
Step 3. Complete Any Additional Pages 
 
Form 532 is a form that is three pages long. Now that you have completed page 1 
and saved your file, you can complete pages 2 and 3 of Form 532-Initial Articles of 
Incorporation. Do this by clicking on the Display menu, then For Profit Corpora-
tion, then Form 532—Initial Articles of Incorporation, and finally on Page 2. 
Page 2 will appear on your screen and you can tab from field to field completing the 
appropriate information. 
 
Page 2 of Form 532 has one interesting feature that we would like to mention. As 
you enter information and tab through the page, you will eventually notice that two 
of the input boxes have blue backgrounds—the last two Date fields near the bottom 
of the page next to the last two Authorized Representative signatures. These 
boxes are overrideable. That means that OBF will usually complete them based on 
your previous entries, but you can change that information by entering your own in-
formation. Here’s an example. If you type July 4, 2005 as the Date next to the first 
Authorized Representative, that date will flow to the other two signature areas 
automatically because it is customary for all individuals to sign on the same date. 
However, if that were not true, you could override either or both of the succeeding 
Date entries. You override an entry by double-clicking in the blue input box, by se-
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lecting Override on the Options menu or by pressing � � . Once you override an 
entry it will always appear in red on your screen as a reminder. To cancel an over-
ride, double-click again in the blue input box, or select Don’t Override on the Op-
tions menu or by press � � .  
 
There’s not much point in giving a field-by-field chronolog of all the entries in the 
Sample file. It’s simply tabbing from field to field and making your entry, much the 
same as you would do with a form in a typewriter. The big difference is that you’ve 
always got the forms handy, corrections are a snap and duplicative information will 
transfer from page to page and form to form automatically. 
 
If you were completing page 2, now would be a good time to click on the Save but-
ton or using the Save command on the File menu. One last thing you may not know 
about tabbing through the forms is that if you hold � down while pressing � the 
focus will move backwards through the form.  
 
Step 4. Pr int the var ious required forms using the 
File|Print|Selected Forms dialog 
 
When you©re satisfied that all the required forms are ready for filing, go to the Se-
lected Forms dialog on the File menu©s Print submenu. Use the tabs along the top 
of the dialog to select forms for different business entities (i.e., For Profit Corpora-
tion, etc.), and check the boxes next to the forms you wish to print. There are six 
pages of checkboxes. Use the arrow buttons on the tab bar to see them all. When 
you’ve checked all your forms, you can click on the Print button. You can print any 
one or batch of Ohio business forms from the Selected Forms dialog. If a particu-
lar form has multiple pages, all parts or continuation pages of the form will be 
printed. 
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This paper manual is merely an initiation outline of the 
basics of installation, getting started and information 
entry. From there, you can get help via the program’s 
Help|Table of Contents menu. 
 
If you’ re like us, you might be doubtful as to whether 
help files can be truly helpful. Regardless of  any draw-
backs, we found them to have significant benefits over their paper counterpart. 
 
Help Is Always There 
When we were at the office, the manual was at home. When were on the computer 
at home, the manual was at the office. On unfortunate occasions, that alone can 
make you lose a day. It never happens with help files. They’ re always there. A 
copy for your home computer, and a separate one for the office. Ditto for your lap-
top! When you’ re desperate for information, you can always count on its accessi-
bility. 
 
Help Is Hyper linked, Searchable &  Better  Indexed. 
We took extra time to develop a logical system of indexing. You should find that a 
help file’s searchability can be a time-saver when you’ re looking for a snatch of 
text. The point and click links between key words provide instant information 
without fumbling though page after page looking for something. This non-linear  
characteristic is part of what makes help files so uniquely useful. 
 
Help Is Up To Date 
Because they are printed in larger quantities, paper manuals fall out of synch with 
last-minute or late-minor programming changes during the duration of the 
“printing.”  Help files, on the other hand, are easier to keep current with program-
ming changes because their modification involves no additional processing steps 
to implement (i.e., physical transportation, printing, binding, etc.). 
 
Paper  Fix 
Don’ t forget that any help topic can be printed simply by pressing the help win-
dow’s Print button, or using the menu’s Print Topic command. 
  

"��-�����#����&���.�#��(
#��"��-�����#����&���.�#��(
#��"��-�����#����&���.�#��(
#��"��-�����#����&���.�#��(
#������



13 

Ohio Business Forms  for Windows 

Checking out the following help topics before 
digging in to OBF will help reduce the learn-
ing curve, although you should find OBF rela-
tively straightforward to use. 
 
1. The Save As Command 
This topic has an inside look at how OBF or-
ganizes the client file set. If you are intending 
to use OBF on a network or copy client files 
from one machine to another, you will want to 
read and/or print this topic. 
 
2. The DEFAULT.OBF File 
You certainly don©t want to enter the county and attorney information over and over 
again each time you start a new guardianship file, so check out this help topic. 
 
3. Overr iding 
You can override the answer in any text input box with an aqua-colored background. 
This help topic explains how.. 
 
4. Using the Keyboard 
This is a good topic to print because it summarizes all the key commands that are 
available in OBF. 
 
5. Common Questions 
If we get recurring questions about a particular facet of OBF’s operation, you will 
find the relevant help topic cited here. 
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